
User Manual

Canopus Co., Ltd.

1-2-2 Murotani, Nishi-ku,

Kobe 651-2241 JAPAN

Printed in JAPAN

Copyright© 2003 Canopus Co., Ltd. All Rights Reserved.

Fourth Edition - November 2003



Notice to Reader

Canopus Co., Ltd. makes no warranty of any kind with regard to this material, including, but not limited to, the
implied warranties of merchantability and fitness for a particular purpose. Canopus shall not be liable for
errors contained herein or for incidental consequential damages in connection with the furnishing, performance,
or use of this material.

This document contains proprietary information which is protected by copyright. All rights are reserved. No
part of this document may be photocopied, reproduced, or translated into another language without the prior
written consent of Canopus Co., Ltd.

The information in this document is subject to change without notice.

FCC Notice

This equipment has been tested and found to comply with the limits for the class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against interference
in a residential installation. This equipment generates, uses and can radiate radio frequency energy and if not
installed, and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try and correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

This equipment has been certified to comply with the limits for a class B computing device, pursuant to FCC
Rules. In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment.
Operation with non-approved equipment or unshielded cables is likely to result in interference to radio and TV
reception. The user is cautioned that changes and modifications made to the equipment without the approval
of manufacturer could void the user's authority to operate this equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.



Warranty

Your DVStorm2 Pro hardware options are covered by a limited warranty when you register your Canopus
product. This warranty is for a period of three years from the date of purchase from Canopus or an
authorized Canopus agent. This warranty applies only to the original purchaser of the Canopus product and
is not transferable. Canopus Co., Ltd. warrants that for this period the product will be in good working order.
Should our product fail to be in good working order, Canopus will, at its option, repair or replace it at no
additional charge, provided that the product has not been subjected to misuse, abuse or non-Canopus
authorized alterations, modifications and/or repair. Proof of purchase is required to validate your warranty.

Canopus Co., Ltd. has gone to considerable effort to make the users manual as accurate as possible at the
time of printing. Canopus cannot assume, however, any responsibility for any inaccuracies that may be
contained in the manual. In no event will Canopus Co., Ltd. be liable for direct, indirect, special, incidental, or
consequential damages resulting from any defect or omission in the manual, even if advised of the possibility
of such damages.

As part of their ongoing process of continued product development, Canopus Co., Ltd. reserves the right to
make improvements in the manual and the products it describes at any time, without notice or obligation.

CANOPUS CO., LTD. IS NOT RESPONSIBLE FOR ANY LOST PROFITS, LOST SAVINGS OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF, OR INABILITY TO USE,
THIS PRODUCT. THIS INCLUDES DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY
LAW, DAMAGES FOR PERSONAL INJURY. THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Declaration of Conformity

According to FCC Part 15

Responsible Party Name: Canopus Co., Ltd.

Address: 1-2-2 Murotani, Nishi-ku, Kobe 651-2241 JAPAN

Declares that product: Model: DVStorm2 Pro

Complies with Part 15 of the FCC Rules.
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Introduction

Chapter 1

Thank you for purchasing the Canopus DVStorm2 Pro
nonlinear digital video editing product. Before you start
using your system, please read this manual and follow
the installation instructions. This will ensure that you
have a trouble-free setup.
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Chapter 1

About This Manual
The information contained in this manual covers the installation and specific functionality
of the DVStorm2 Pro.

Chapter 1 - Introduction
Provides information about contacting us and using this manual.

Chapter 2 - Installation
Explains step-by-step instructions on installing DVStorm2 board and application software including device
drivers into your computer system.

Chapter 3 - Connecting Devices
Provides several scenarios and examples for connecting your DV or analog device to DVStorm2 unit or
StormBay, which is an optionally available unit.

Chapter 4 - Status of StormBay
Describes status LED of StormBay, which is an optionally available unit.

Chapter 5 - Third Party Plug-Ins
Describes additional features included in the DVStorm2 Pro package.

Chapter 6 - Canopus DV Capture
Describes details of Canopus DV Capture application bundled with the DVStorm2 Pro package.

Chapter 7 - MPEGcapture
Describes details of MPEGcapture application bundled with the DVStorm2 Pro package.

Chapter 8 - Power Management Property
Describes details of Power Management Property for supporting Window's Power Management modes.

Chapter 9 - Notes and Limitations
Provides informative notes about DVStorm2 Pro, as well as its limitations.

Trademarks
DVStorm2 Pro and EDIUS are trademarks of Canopus Co., Ltd. i.LINK is a trademark of Sony Corporation.
Premiere Pro is a trademark of Adobe Systems. DirectDraw and IntelliMouse are trademarks of Microsoft.
DVD WorkShop and Cool 3D Studio are trademarks of Ulead Systems. ACID Style is a trademark of Sonic
Foundry. All other trademarks and registered trademarks belong to their respective holders.



Installation

Chapter 2

This text shows updated information regarding the new
package contents and installation steps regarding your
DVStorm2 Pro package. Please refer to this manual
before installing your DVStorm2 unit.
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Package Contents
The below items are included in your DVStorm2 Pro package:

• 1 x DVStorm2 board
• 1 x DVStorm2 Component Option*
• 1 x StormEncoder*
• 1 x Component Option cable* (DVStorm2 board to DVStorm2 Component Option)
• 1 x DV Cable (4-pin to 4-pin)
• 2 x Stereo audio cable (stereo mini-jack male to RCA L/R female)
• 2 x Composite video adapter cable (mini-DIN to RCA female)
• 1 x Gasket
• 1 x DVStorm2 Pro User Manual (This manual)
• 1 x MPEGcraft User Manual
• 5 x CD-ROM

EDIUS LE V.1.5 Install CD
DVStorm2 Pro Application CD
ACID Install CD
DVD WorkShop SE Install CD
Cool 3D Studio SE for Canopus CD

* DVStorm2 Component Option, StormEncoder, and the cable for the Component Option may not be
included in the package according to the one you purchased.

System Requirements
Make sure your computer system meets the following minimum requirements:

2 free PCI v2.1 slots (One is for DVStorm2 board, the other is for DVStorm2 Component Option if it's available.)
1 free IRQ
Single Pentium III 700MHz CPU or over
256MB RAM
CD-ROM Drive
100MB free hard disk space
Microsoft® Windows® 2000, Windows® XP Home Edition, Windows® XP Professional
VGA card with hardware DirectDraw overlay support
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Detailed Requirements

IRQ requirements

DVStorm2 Pro requires one free IRQ. While DVStorm2 unit can share IRQs with other devices, many
devices that report they can share IRQs do not share IRQs properly.
For best results, try to get DVStorm2 unit on its own IRQ, preferably 9 or higher.

PCI slot requirements

DVStorm2 Pro requires a free PCI v2.1 slot. For best results, we do NOT recommend installing DVStorm2
board in the PCI slot that shares resources with the AGP slot, as this can often cause problems. If your
package contains DVStorm2 Component Option, another PCI slot is required.

Graphics board

To display and overlay video on the VGA monitor you need a graphics board that supports hardware
DirectDraw and DirectDraw overlay. Check the Canopus website for a list of compatible VGA cards, or use
Storm Test to check your card's compatibility.

Hard disk requirements

When working with DV data in realtime, a high sustained data throughput is necessary. We recommend a
dedicated hard disk with a sustained data transfer rate of at least 10MB/Sec for video. Popular video editing
storage configurations include UltraATA33 drives, UltraATA66 drives, Ultra Wide SCSI controllers and Ultra
Wide SCSI hard disks.
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Hardware Installation
This section contains instructions on how to install the DVStorm2 Pro hardware. Please
follow the instructions below while installing the DVStorm2 unit.

The tools needed for installation:
• A Phillips head screwdriver
• Your PC's User's Manual

Installing DVStorm2 Board
This section explains how to install DVStorm2 board to your PC.

1. Shut down Windows and unplug the power cable of your PC before installation.

2. Remove the cover of your PC.

3. Connect DVStorm2 board and DVStorm2 Component Option with the supplied Component Option
cable. Plug the cable to the 26-pin connector.
If your package doesn't include DVStorm2 Component Option, skip this step.

4. Attach the supplied gasket to the edge of the DVStorm2 board to reduce noise.

5. Insert DVStorm2 board securely to the one of the PCI slots and DVStorm2 Component Option to
the other.

NOTE:
Static electricity can damage electronic components. Take care not to touch connectors
or cards directly. When installing or working on your PC, first touch a grounded metal
surface. This will discharge any static electricity on your body.



7
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6. Reposition jumpers between pins on the DVStorm2 board as shown below.
When you use internal DV port, see illustration A. When you use external DV port, see illustration B.
You may use either port for DV input/output.

          

7. Fasten the brackets of the board and the component option with screws to your PC.

Installing DVStorm2 Board With StormBay
StormBay is an optionally available unit. The unit installed in the front 5-inch bay of your PC enables smooth
connection between DVStorm-RT and a video tape recorder.

1. Follow the step 1 to 6 to install DVStorm2 board and DVStorm2 Component Option (If your
package includes DVStorm2 Component Option).

2. After installation of DVStorm2 board, then insert StormBay to the front 5-inch bay.

3. Connect DVStorm2 board and StormBay unit with the internal connection cable and DV cable,
which are both included in the StormBay package.

4. Fasten the brackets of the board and the component option with screws to your PC. Fasten the
unit to your PC's front panel as well.
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Software Installation

Installing Drivers
The first time you start Windows after installing the DVStorm2 unit, the Add New hardware dialog will appear.
Insert EDIUS LE V.1.5 Install CD in your CD-ROM drive and point the Add New Hardware wizard to look in
D:\Drivers\DVStorm-RT (where D: is the letter of your CD-ROM drive). Follow the on-screen instructions to
install the DVStorm drivers.
After the DVStorm drivers are installed, restart your computer and install Applications as stated below.

Installing Applications
You have three options to edit digital video file with DVStorm2 Pro. One is editing with Canopus EDIUS LE, and
the other is with Adobe Premiere Pro or with both editing applications. To install Canopus EDIUS LE, follow
instructions below.

When you want to use Adobe Premiere Pro with DVStorm2 Pro, you are required to install some plug-ins. To
install these, please refer to "Premiere Pro Plug-ins". When you want to use other editing applications with
DVStorm2 Pro, we provide some video out plug-ins. To install these, please refer to "Video Out plug-ins for
other applications".

Canopus EDIUS LE

To install Canopus EDIUS LE for DVStorm2 Pro, insert EDIUS LE V.1.5 Install CD in your CD-ROM drive. The
setup launcher will start automatically. Locate and run Launcher.exe if it does not start automatically.

Follow the prompts to install the EDIUS LE, EDIUS FX, ProCoder LE for EDIUS, Xplode Basics for EDIUS,
Title Express LE for Canopus, Windows Media, and Quick Time. These are necessary applications for
operating with EDIUS LE.

EDIUS LE - This is an application for real-time digital video editing. It maximizes your computer's hardware
circumstances to create digital video files, and provides smooth operations.

EDIUS FX/Xplode Basics for EDIUS - These are applications for adding 2-D and 3-D transition effects to
the video file you created.
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ProCoder LE for EDIUS - This is an application for conversion of video file format. It converts data with little
degradation to image and sound.

Title Express LE for Canopus - This is an application for generating 3-D effect titles for the video file you
created. It is installed automatically.

Windows Media - This is an application for playing .WVM or .ASF video format files which are commonly
used in Windows. It is installed automatically.

Quick Time - This is an application for playing Quick Time video format files which are commonly used in
Macintosh. It is installed automatically.

During installation, setup may ask you if you want to restart your computer. Go ahead and follow the prompts.
The next part of setup will automatically launch after the computer restarts.

Premiere Pro Plug-ins

For editing digital video file with DVStorm2 Pro using Adobe Premiere Pro as an editor, it is necessary to install
some plug-ins. To install these, insert DVStorm2 Pro Application CD in your CD-ROM drive. The setup
launcher screen will open automatically. Locate and run Launcher.exe if it does not automatically start. Click
[Install 3rd Party Plug-ins] to start the installation. Follow the prompts to install some plug-ins for Adobe
Premiere Pro.

NOTE:
You may want to uninstall EDIUS LE and install it again to fix the unexpected problems
which might occur. In that case, note that you are required to install EDIUS LE after
uninstallation is completely finished. When you uninstall the application, the dialog
appears urging you to reboot the computer. Follow the on-screen instructions, otherwise
EDIUS LE will not be installed to the computer for good.

NOTE:
Plug-ins for Adobe Premiere 6.5 and the previous versions are not included with this
package. Please refer to the Canopus website for these plug-ins.

NOTE:
If you are using Adobe Premiere Pro only, you are required to install Canopus DV
Driver, as well. To install it, locate and run setup.exe which is under Plug-in\Canopus in
the included DVStorm2 Pro Application CD. However, if you have already installed
EDIUS LE, it is not necessary to install the driver.
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Video Out plug-ins for other applications

When you want to use other editing applications with DVStorm2 Pro, we provide some video out plug-ins. To
install the video-out plugins for After Effects, Photoshop, or LightWave 3D, install the target application first,
then insert DVStorm2 Pro Application CD in your CD-ROM drive. The setup launcher screen will open
automatically. Locate and run Launcher.exe if it does not automatically start. Click [Install 3rd Party Plug-ins]
to start the installation. The installation will start after installation of Premiere Pro Plug-ins. Follow the prompts
to install video out plug-ins.

* During installation of the Video Out plug-ins, make sure whether the target application is selected.

Installing Bundled Applications

MPEGcraft LE

This is an application for editing digital video files, specializing in MPEG1 and MPEG2 formats. It can edit
MPEG files in GOP or frame unit. To install this application, insert DVStorm2 Pro Application CD in your CD-
ROM drive. The setup launcher screen will open automatically. Locate and run Launcher.exe if it does not
automatically start. Click [Install DVStorm Applications] to start the installation.

MPEGcapture

This is an application for capturing MPEG1/2 files directly from video (both S-video and composite) /audio/
DV jack of the DVStorm2 unit with Canopus StormEncoder. You can also preview the captured files with
DVStorm2 unit in realtime. To install this application, use DVStorm2 Pro Application CD. Normally, the installation
of this application will start right after the installation of MPEGcraft LE.

Canopus DV Capture

This is a DV capture application for DV capture via general IEEE1394 boards and for simultaneous capture
with the DVStorm2 unit. You can connect at most 3 cameras for capturing images. With this application, you
can capture 3 images simultaneously from two cameras connected to the IEEE1394 boards and one camera
connected to the DVStorm2 unit. To install this application, use DVStorm2 Pro Application CD. Normally, the
installation of this application will start right after the installation of MPEGcraft LE and MPEGcapture.

Ulead DVD WorkShop SE

This is a DV authoring application. To install DVD WorkShop SE, insert the DVD WorkShop SE Install CD in
your CD-ROM drive. The setup will start automatically. First select your language, then follow the on-screen
prompts.

ACID Style

This is an audio loop sequencer. It can create audio tracks which are utilized in the video files as background
music. To install ACID, insert the ACID Install CD in your CD-ROM drive. Locate and run Setup.exe if it does
not automatically start.
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Cool 3D Studio SE for Canopus

This is an application for generating 3-D effect titles for the video file you created. To install Cool 3D Studio SE,
insert the Cool 3D Studio SE for Canopus CD in your CD-ROM drive. Locate and run Setup.exe if it does not
automatically start.

Upgrading Drivers
When you have already installed previous version of Canopus DVStorm software, upgrading drivers is
necessary. To do so, follow below instructions.Below instructions are explained based on Windows 2000.
According to Windows OS version you are using, the instructions are slightly different from what is mentioned
here.

1. Uninstall your current version of the Canopus software. Do this from the Add/Remove Programs
window.

2. Now install the drivers for the DVStorm2 board. Start by opening the Device Manager in Windows.
You can do this by right clicking on My Computer icon then selecting Properties. When the System
Properties window comes up, click on the Hardware tab, then click on the Device Manager button.

3. When the Device Manager is open, double click on the Sound, Video, and Game Controllers icon.
You should see the DV Storm-RT listed. If you do not see it there, it may be under Other Devices as
a Multimedia controller. Double click on the DVStorm-RT (or Multimedia controller) to open the
DVStorm-RT Properties window.

4. In the DVStorm-RT Properties window, click on the Driver Tab, then on the Update Driver... button.

5. You will now see the first screen of the Windows Update Device Driver Wizard. Click Next and the
next screen will come up asking "What do you want the wizard to do?" Select "Display a list of the
known drivers for this device..." and click Next.

6. Now the "Select a Device Driver" window will be displayed. Click on the Hard Disk... button. Click
on Browse in the Install From Disk windows that comes up. Browse to the Drivers and find the
DVStorm-RT.INF file. Double click on this DVStorm-RT.INF and the Install From Disk window will
reappear. Click OK and the "Select a Device Driver" window will be displayed again. Click Next.

7. Click Next at the "Start Device Driver Installation" window. A window will appear informing you that
the Microsoft Digital Signature cannot be found for this device. Click Yes to continue the installation
anyway.

8. Now the "Completing the Upgrade Device Driver Wizard" screen will be displayed. Click on
Finish, then click on the Close button to close the DVStorm-RT Properties window. You will be
prompted to restart the computer. Click Yes to restart the computer.

9.  Install applications referring to the next section.
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Connecting Devices

Chapter 3

This chapter describes how to connect a typical analog
and DV camera or deck. The individual connections for
your device may be different from what is described
here. Please consult the manual for your camera or
deck for specific information about your equipment.

For each connection example, there are two sections -
connecting to StormBay, which is an optionally
available unit, and connecting directly to DVStorm2
unit. Follow the instructions in the appropriate section
for your setup.
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Connecting DV Camera/Deck for Capture & Output

Connecting With StormBay

Connect DV

Connect one end of the supplied DV cable to your camera or deck's DV jack. Connect the other end of the DV
cable to the DV jack on the StormBay. This is the only connection necessary for a DV camera or deck for both
capture and output.

If you're not going to use the analog output to connect to a preview video monitor, or plan to connect it to a
device that does not accept audio, you may want to consider routing the analog audio output on the
StormBay to the Line In on your soundcard so you can hear sound through your computer speakers while
editing. You can also use the analog audio output on the DVStorm2 unit itself to run sound to your sound card.
You can use the analog audio output of the DVStorm2 unit itself and the StormBay simultaneously without
signal loss.
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Connecting Devices

Connecting Without StormBay

Connect DV

Connect one end of the supplied DV cable to your camera or deck's DV jack. Connect the other end of the DV
cable to the DV jack on the DVStorm2 unit. This is the only connection necessary for a DV camera or deck
for both capture and output.

If you're not going to use the analog output to connect to a preview video monitor, or plan to connect it to a
device that does not accept audio, you may want to consider routing the analog audio output to the Line In
on your soundcard so you can hear sound through your computer speakers while editing.

Connecting Analog Camera/Deck for Capture

Connecting With StormBay

Connect video

The method you use of connecting the video output of your camera or deck to the StormBay depends on
what connectors your camera or deck has. Follow the appropriate step(s) below.

DVStorm2
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Connecting via S-Video - Connect a S-Video cable from the S-Video input jack on the StormBay to the S-
Video output jack of your camera or deck.
S-Video is the preferred connection method for analog video.

Connecting via Composite - Connect a composite video cable from the Video input jack on the StormBay
to the Video output on your camera or deck.

Composite video cable
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Connecting Devices

Connecting via A/V jack - Connect the video output of the A/V cable for your camera or deck from the
Video input jack on StormBay to the A/V jack on your camera or deck.

Connect audio

The method of connecting the audio output of your camera or deck to the StormBay depends on what
connectors your camera or deck has. Follow the appropriate steps below.

Connecting via RCA - Connect a stereo RCA patch cable (or a pair of RCA cables) from the Audio input
jacks on the StormBay to the RCA audio jacks on your camera or deck.

A/V cable (has three plugs)

NOTE:
Make sure you use the correct A/V cable for your camera or deck. An audio Y-cable will
not work.

Stereo RCA patch cable

NOTE:
Remember, red is right, white is left. Make sure the connectors match or your audio
channels may be swapped.
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Connecting via A/V jack - Connect the audio outputs of the A/V cable for your camera or deck to the
Audio input jacks on the StormBay. Next, connect the A/V cable to the A/V jack on your camera or deck.

Connect via Headphone output jack - Since headphone output levels are generally not the same as line-
level output, this method of connection is not recommended. Connect a stereo audio Y-cable from your
camera or deck's headphone out jack to the Audio input jacks on the StormBay.

NOTE:
Make sure you use the correct A/V cable for your camera or deck. An audio Y-cable will
not work. Remember, red is right, white is left. Make sure the connectors match or your
audio channels may be swapped.

A/V cable (has three plugs)

Stereo audio Y-cable

NOTE:
Remember, red is right, white is left. Make sure the connectors match or your audio
channels may be swapped.
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Connecting Without StormBay

Connect video

The method of connecting the video output of your camera or deck to DVStorm2 unit depends on what
connectors your camera or deck has. Follow the appropriate step below.

Connecting via S-Video - Connect a S-Video cable from the S-Video input jack on the DVStorm2 unit to the
S-Video output jack of your camera or deck. S-Video is the preferred connection method for analog video.

Connecting via Composite - Connect one of the composite video adapter cables from the DVStorm2 Pro
package to the Video In jack on DVStorm2 unit. Next, connect a composite video cable from the composite
video adapter cable to the Video output jack on your camera or deck.

DVStorm2

NOTE:
Only use the composite adapter cable that is included with DVStorm2 Pro package. Using
a different adapter cable may cause damage to DVStorm2 unit or your equipment.

Composite video adapter cable

Composite video cable

DVStorm2
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Connecting via A/V jack - Connect one of the composite video adapter cables from the DVStorm2 Pro
package to the Video In jack on DVStorm2 unit. Next, connect the video output of the A/V cable for your
camera or deck to the composite video adapter cable. Finally, connect the A/V cable to the A/V jack on your
camera or deck.

NOTE:
Only use the composite adapter cable that is included with DVStorm2 Pro package. Using a
different adapter cable may cause damage to DVStorm2 unit or your equipment. Make sure
you use the correct A/V cable for your camera or deck. An audio Y-cable will not work.

DVStorm2

Composite video adapter cable

A/V cable (has three plugs)
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Connecting Devices

Connect audio

The method of connecting the audio output of your camera or deck to DVStorm2 unit depends on what
connectors your camera or deck has. Follow the appropriate step below.

Connecting via RCA - Connect one of the stereo audio cables from the DVStorm2 Pro package to the
Audio In jack on DVStorm2 unit. Next, connect a stereo RCA patch cable (or a pair of RCA cables) from the
stereo audio cable to the audio output jacks on your camera or deck.

NOTE:
You can use a Stereo RCA male to stereo mini-jack cable instead of the cables described
here. Remember, red is right, white is left. Make sure the connectors match on both ends
or your audio channels may be swapped.

DVStorm2

Stereo audio cable

Stereo RCA patch cable
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Connecting via A/V jack - Connect one of the stereo audio cables from the DVStorm2 Pro package to the
Audio In jack on DVStorm2 unit. Next, connect the audio outputs of the A/V cable for your camera or deck to
the stereo audio cable. Finally, connect the A/V cable to the A/V jack on your camera or deck.

Connect via Headphone output jack - Headphone output levels are not the same as line-level output.
This connection method is not recommended. Connect a stereo mini-jack patch cable from your camera or
deck's headphone out jack to the Audio In jack on DVStorm2 unit.

DVStorm2

Stereo audio cable

A/V cable (has three plugs)

DVStorm2

Stereo mini-jack patch cable

NOTE:
Make sure you use the correct A/V cable for your camera or deck. An audio Y-cable will
not work. Remember, red is right, white is left. Make sure the connectors match or your
audio channels may be swapped.
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Connecting Analog Camera/Deck for Output

Connecting With StormBay

Connect video

The method of connecting the StormBay to the video input of your camera or deck depends on what
connectors your camera or deck has. Follow the appropriate step below.

Connecting via S-Video - Connect a S-Video cable from the S-Video output jack on the StormBay to the
S-Video input jack of your camera or deck. S-Video is the preferred connection method for analog video.



24

Chapter 3

Connecting via Composite - Connect a composite video cable from the Video output jack on the
StormBay to the Video input on your camera or deck.

Connecting via A/V jack - Connect the video I/O of the A/V cable for your camera or deck from the Video
output jack on StormBay. Connect the other end of the A/V cable to the A/V jack on your camera or deck.

Composite video cable

NOTE:
Make sure you use the correct A/V cable for your camera or deck. An audio Y-cable will
not work.

A/V cable (has three plugs)
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Connect audio

The method of connecting the StormBay to the audio input of your camera or deck depends on what
connectors your camera or deck has. Follow the appropriate step below.

Connecting via RCA - Connect a stereo RCA patch cable (or a pair of RCA cables) from the Audio output
jacks on the StormBay to the RCA audio input jacks on your camera or deck.

Stereo RCA patch cable

NOTE:
Remember, red is right, white is left. Make sure the connectors match on both ends or
your audio channels may be swapped.
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Connecting via A/V jack - Connect the audio inputs of the A/V cable for your camera or deck to the Audio
output jacks on the StormBay. Next, connect the A/V cable to the A/V jack on your camera or deck.

Connecting Without StormBay

Connect video

The method of connecting the DVStorm2 unit to the video input of your camera or deck depends on what
connectors your camera or deck has. Follow the appropriate step below.

Connecting via S-Video - Connect a S-Video cable from the S-Video output jack on the DVStorm2 unit to
the S-Video input jack of your camera or deck. S-Video is the preferred connection method for analog video.

NOTE:
Make sure you use the correct A/V cable for your camera or deck. An audio Y-cable will
not work. Remember, red is right, white is left. Make sure the connectors match or your
audio channels may be swapped.

A/V cable (has three plugs)

DVStorm2
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Connecting via Composite - Connect one of the composite video adapter cables from the DVStorm2 Pro
package to the Video Out jack on DVStorm2 unit. Next, connect a composite video cable from the composite
video adapter cable to the Video input jack on your camera or deck.

NOTE:
Only use the composite adapter cable that is included with DVStorm2 Pro package. Using
a different adapter cable may cause damage to DVStorm2 unit or your equipment.

DVStorm2

Composite video adapter cable

Composite video cable
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Connecting via A/V jack - Connect one of the composite video adapter cables from the DVStorm2 Pro
package to the Video In jack on DVStorm2 unit. Next, connect the video output of the A/V cable for your
camera or deck to the composite video adapter cable. Finally, connect the A/V cable to the A/V jack on your
camera or deck.

NOTE:
Only use the composite adapter cable that is included with DVStorm2 Pro package. Using a
different adapter cable may cause damage to DVStorm2 unit or your equipment. Make sure
you use the correct A/V cable for your camera or deck. An audio Y-cable will not work.

DVStorm2

Composite video adapter cable

A/V cable (has three plugs)
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Connect audio

The method of connecting DVStorm2 unit to the audio input of your camera or deck depends on what
connectors your camera or deck has. Follow the appropriate step below.

Connecting via RCA - Connect one of the stereo audio cables from the DVStorm2 Pro package to the
Audio Out jack on DVStorm2 unit. Next, connect a stereo RCA patch cable (or a pair of RCA cables) from the
stereo audio cable to the audio input jacks on your camera or deck.

DVStorm2

Stereo audio cable

Stereo RCA patch cable

NOTE:
You can use a Stereo RCA male to stereo mini-jack cable instead of the cables described
here.
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Connecting via A/V jack - Connect one of the stereo audio cables from the DVStorm2 Pro package to the
Audio Out jack on DVStorm2 unit. Next, connect the audio inputs of the A/V cable for your camera or deck to
the stereo audio cable. Finally, connect the A/V cable to the A/V jack on your camera or deck.

NOTE:
Make sure you use the correct A/V cable for your camera or deck. An audio Y-cable will
not work. Remember, red is right, white is left. Make sure the connectors match or your
audio channels may be swapped.

DVStorm2

Stereo audio cable

A/V cable (has three plugs)
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Connecting to Video Monitor for Preview
You can connect a video monitor to DVStorm2 unit for output preview while editing.

Connecting With StormBay

Connect video

The method of connecting the StormBay to the video input of your video monitor depends on what connectors
your camera or deck has. Follow the appropriate step below.

Connecting via S-Video - Connect a S-Video cable from the S-Video output jack on the StormBay to the
S-Video input jack of your video monitor. S-Video is the preferred connection method for analog preview to
a video monitor.
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Connecting via Composite - Connect a composite video cable from the Video output jack on the
StormBay to the Video input on your video monitor.

Composite video cable
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Connect audio

Connect a stereo RCA patch cable (or a pair of RCA cables) from the Audio output jacks on the StormBay
to the RCA audio input jacks on your video monitor.

Stereo RCA patch cable

NOTE:
Remember, red is right, white is left. Make sure the connectors match on both ends or
your audio channels may be swapped.
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Connecting Without StormBay

Connect video

The method of connecting the DVStorm2 unit to a video monitor depends on what connectors your video
monitor has. Follow the appropriate step below.

Connecting via S-Video - Connect a S-Video cable from the S-Video output jack on the DVStorm2 unit to
the S-Video input jack of your video monitor. S-Video is the preferred connection method for analog preview
to a video monitor.

DVStorm2
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Connecting via Composite - Connect one of the composite video adapter cables from the DVStorm2 Pro
package to the Video Out jack on DVStorm2 unit. Next, connect a composite video cable from the composite
video adapter cable to the Video input jack on your video monitor.

NOTE:
Only use the composite adapter cable that is included with DVStorm2 Pro package. Using
a different adapter cable may cause damage to DVStorm2 unit or your equipment.

DVStorm2

Composite video cable

Composite video adapter cable
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Connect audio

Connect one of the stereo audio cables from the DVStorm2 Pro package to the Audio Out jack on DVStorm2
unit. Next, connect a stereo RCA patch cable (or a pair of RCA cables) from the stereo audio cable to the
audio input jacks on your video monitor.

Selecting Proper Input Channel
When capturing using DVStorm2 Pro, it is important to select the proper input channel
in the program you're capturing from. See respective user's manuals for instructions
on how to select your input channel.

NOTE:
You can use a Stereo RCA male to stereo mini-jack cable instead of the cables described
here.Remember, red is right, white is left. Make sure the connectors match on both ends
or your audio channels may be swapped.

DVStorm2

Stereo RCA patch cable

Stereo audio cable



Status of StormBay

Chapter 4

This chapter describes status LED of StormBay, which
is an optionally available unit.
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Status of StormBay

DV Status

The DV status light appears lit when the StormBay DV connection is active for input and output.
Only one DV connection can be active at a time.

S-Video In Status

The S-Video In I/O status light appears lit when the StormBay S-Video connection is active for input.
Although all connections are active for output, only one analog video connection can be active for input at one
time.
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Video In Status

The Video In status light appears lit when the StormBay composite connection is active for input.
Although all connections are active for output, only one analog video connection can be active for input at one
time.

Audio In Status

The Audio In status light appears lit when the StormBay analog audio connection is active for input.
Although all connections are active for output, only one analog audio connection can be active for input at one
time.

Input Aux Status

The Input Aux status light is reserved for future use and will appear lit when an auxiliary input is active.
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Third Party Plug-Ins

Chapter 5

This chapter describes additional features included in
the DVStorm2 Pro package.
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Real-Time in Adobe Premiere Pro
This section describes the procedures for real-time editing in Adobe Premiere Pro
using the Canopus real-time Premiere Pro plug-in.

The Canopus real-time editing plug-in for Adobe Premiere Pro allows you to use video filters, luminancekeys,
picture-in-picture, chromakeys, audio filters, title motion filters, transitions, and filters from within Adobe
Premiere Pro when editing DV clips. Furthermore, it allows capture and real-time output of the timeline directly
from Premiere Pro.

This section assumes you have working knowledge of Adobe Premiere Pro and its interface. If you are
unfamiliar with Premiere Pro, we suggest you go through the Premiere Pro tutorial before attempting to use
Canopus real-time features within Premiere Pro. All the graphics in this chapter are based on Adobe Premiere
Pro. If you have not installed either Adobe Premiere Pro or the Canopus real-time plug-in for Adobe Premiere
Pro to your PC yet, please refer to Chapter 2 to install both.

Captured images used in this section are from Windows XP.

Creating New Projects

Starting the application

1. Click on the New Project icon to start Premiere Pro.
Refer to the manual attached to the Premiere Pro CD for running.

NOTE:
You are not able to use EDIUS or video out plug-ins while you are operating with
Premiere Pro plug-ins.
It is of extreme importance that no other programs are running while editing in Premiere Pro.
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2. Click OK after selecting parameters, such as video formats and aspect ratio, and entering a
project name.

Choose one of the followings for configuration of a project according to the video format you specified
during installation.

• Canopus DV-NTSC
Standard 32Khz
Standard 44.1Khz
Standard 48Khz
Widescreen 32Khz
Widescreen 44.1Khz
Widescreen 48Khz

• Canopus DV-PAL
Standard 32Khz
Standard 44.1Khz
Standard 48Khz
Widescreen 32Khz
Widescreen 44.1Khz
Widescreen 48Khz

Playback settings

The plug-in playback settings affect certain features as well as the amount you can do in real-time.

1. From Project menu, select Project Settings > General.
Project Settings dialog opens, and Canopus RealTime DV or other items appear in the Editing Mode
according to your system.
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2. Click the Playback Settings button.

3. Check required options and click OK.

• Enable monitor out preview - This option enables video and audio preview while showing filter
setup dialog. Timeline output is always active whether this option is set or not.

• Show buffer status - When you check this option, the playback buffer (see Playback Buffer and
Non-real-time Effects section) status is displayed on the Premiere Pro monitor.

• Stop playback at frame drop - When you check this option, timeline playback will stop when a
frame drop occurs. Without this checked, timeline playback will drop frames if there are too many
effects for the system to play back in real-time.

• Color Space - This option instructs the plug-in to work either in YUV colorspace or RGB colorspace.
Set it to YCbCr (ITU-R BT.601 Compatible) when you do not need to export AVIs to other programs.
Set it to RGB Emulation before exporting AVIs out for other programs.

• Performance - Selecting Standard enables a smooth playback, yet a time lag between pressing
Play button and the actual playback increases. Selecting Quick Response optimizes parameters to
start a playback immediately after pressing the Play button, while the processing may be too late for
start of the playback.

• Overlay quality - High raises quality of the display but facilitates stopping the realtime playback.
Selecting Low decreases a data transfer load of PCI bus, which makes real-time playback easier
to continue.

• Decision - Select All Rendering to decide every section of the timeline with effects, including filters
and transitions that allow a real-time playback, require rendering. Select All Realtime to decide only
sections of the timeline with effects that forbid a real-time playback require rendering. Also despite
of selecting "All Rendering," sections forbidding real-time playback can be rendered during the
preview by the Space key.
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4. Click OK in the dialog at step1.

Useful functions

• Control with the keyboard
  After completing various settings of video filters, luminancekey, picture in picture, chromakey, audio

filters, title motion filters, and transitions, pressing the Space key on the keyboard enables to start real-
time playback. Pressing the Enter key on the keyboard enables to process rendering if necessary
(sections including audio and non-real-time require rendering).

• Speed control function
  Right-click on a clip to select Speed > Duration. The playback speed can be changed (refer to Help).

• Shuttle function
  "J," "K," and "L" keys on the keyboard are assigned for shuttle operations.

  J key is for Reverse Playback
  K key is for Stop
  L key is for Forward Playback
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Setting Device Control
In order to use the DV device control in Batch Capture and Movie Capture, you need to make sure Premiere
Pro is using the appropriate device control module.

Opening the DVStorm-RT Properties dialog

1. From Edit menu, select Preferences > Device Control.
The Preferences dialog opens.
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2. Make sure that Canopus DV Device Control is selected as Devices, then click the Options button.
The DVStorm-RT Properties dialog opens.

3. Specify the settings by following the sections below.

Device Control - Compression Settings
When performing source data compression and decompression in software, use the check box to select
whether to perform color conversion compensation.

YUV and RGB conversions

When converting from YUV to RGB, it may not be possible to convert some colors when the ratio of
luminance to chrominance is 1:1, which results in inaccurate color reproduction. When this check box is
checked, the system expands the conversion axis up to 150%, reducing the range of colors that cannot be
converted.
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Device Control - Detailed Settings
Set operating mode of DVStorm-RT.

Video

• Video Standard - Specify the input video signal format. If "Count Dropped Frames in Time Display" is
checked, the timecode display is switched to drop frame timecord.

• Field during pause - Set the field output status during pause.
FRAME: Both odd and even fields are output in a pause.
ODD: Odd field is output in a pause.
EVEN: Even field is output in a pause.

• Setup - Output black (setup) level is specified here. Either 0IRE or 7.5IRE can be selected for Black
(setup) level. Usually choose "7.5IRE" corresponding to system requirements when your edit system
has overseas DV system. Black (setup) level setting is available only for NTSC.

• DV Format - Select a desired DV format.
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Playback Buffer

Buffer Size - Set playback buffer size here. When buffer setting exceeds the physical memory capacity of
your system environment, the message "Memory may be insufficient. Do you want to continue?" appears on
the dialog box. Click Cancel.
You can increase the buffer size, starting from 128MB for one second (default setting), 192MB for 2 seconds,
and increase one second buffer for every additional 64MB.
When "Automatic" is selected, the buffer is automatically set to the optimized value for the current system
memory. Some system may hang-up at the start. In such case, remove DVStorm-RT board temporary from
your computer, restart it and open "Def_NT.reg" file in the application folder after starting Windows (right-
click and select "Combine," or double-click it). Turn off your computer, install DVStorm-RT board again and
restart the computer.
For Premiere Pro, do not select "Automatic" setting. You need to restart your computer after changing the
buffer size. Be sure to save your data before making any changes to the buffer size.
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Device Control - INPUT1/INPUT2
Settings of analog input movie from INPUT1 (IN1) and INPUT2 (IN2) are specified in this tab. INPUT2 (IN2)
is displayed when StormBay is installed. (It is not indicated without StormBay.) INPUT2 (IN2) is assigned for
settings of StormBay.

Video Input (analog input)

Mapping - Video input terminal assigned to INPUT 1 or INPUT2 (with StormBay) is specified.

Image Adjustments (analog input)

• Brightness - Brightness of picture is adjusted. Lower value becomes darker. Higher value becomes
lighter.

• Contrast - Contrast of picture is adjusted. Lower value becomes fainter contrast. Higher value becomes
intenser contrast.

• Saturation - Color depth is adjusted. Lower value becomes paler color. Higher value becomes deeper
color. When zero is set, the color becomes grayscale completely.

• Hue - Image tone is adjusted. Lower value becomes deeper green. Higher value becomes deeper red.
• Sharpness - An image outline is adjusted. Lower value blurs an image outline. Higher value emphasizes

an image outline.
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Setup Level Setting

Black (Setup 0 level) of input signal into INPUT1 or INPUT2 (with StormBay) can be specified. Usually set the
black (setup) level to "0IRE". When your edit system has overseas DV system, select "7.5IRE" as needed.

* Black (Setup) level settings is available only when using NTSC.
* IRE is a relative unit indicating image amplitude from Black level of video signal (condition of no setup level)

to White level.

Device Control - SyncRec
Delay settings for SyncRec are specified in this tab.

Offset Time

• Start Point - Set AVI playback-start delay time after DV deck recording is started in SyncRec mode. For
example, if "7" is set, starting of video deck recording is delayed for 7 frames than starting of AVI file
playback.

• End Point - Set DV deck recording-end delay time after AVI playback is finished in SyncRec mode. For
example, if "-7" is set, ending of video deck recording is 7 frames earlier than ending of AVI file playback.

Record Position on Tape

Steps - Some kinds of DV system may overwrite necessary data because it is starting to record a few
frames earlier than the pause point in SyncRec. When the gap between pause point and starting point of real
recording occurs, compensation value must be set. Setting the value to zero annuls compensation.
Number of steps is the number of times the frame drive command occurs.
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In general, capturing Reference AVIs in Premiere Pro is not recommended, because Movie Capture captures
to a temporary file first, then copies the AVI to the location you specify. The copied AVI still references the
temporary file, which will cause problems when Premiere Pro eventually overwrites the temporary file with a
new capture.

If you have the need to capture Reference AVIs in Premiere Pro, make sure you don't manually capture
anything in Movie Capture while the option is selected. Use Batch Capture instead.

Editing in Premiere Pro
Using the Canopus real-time plug-in for Premiere Pro, you can edit Canopus DV AVI clips and Premiere Pro-
supported still images and titles in real-time using the Canopus transitions and filters.

To utilize the real-time power of your system, you need to use the special Canopus transitions and filters.
Standard Premiere Pro filters and transitions as well as third-party transitions and filters will still need to be
rendered.

Adding transitions

1. To add Canopus real-time transitions to the timeline, choose one of the Canopus transitions from
the Effects list tab in the Project window, which is under the Video Transitions folder.

2. Drag the transition you selected and drop it onto a clip located on the timeline.
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3. Click on the transition you inserted.
The Monitor window opens with the Effect Controls tab selected.

4. Click the Custom button in the tab to bring up the transition settings.
The custom settings dialog opens.

Any additional transitions can be installed for using Premiere Pro, which can be done in the custom
settings dialog shown above.

It is important to note that only the Basic transitions will work in real-time. Other transitions installed
optionally that appear on the list will not play back in real time. You should use the Premiere Pro
versions of any non-Basic transitions, if possible. For example, Xplode DVStorm Pack will appear in
the list of transitions. However, you should use the native Premiere Pro versions of these transitions
instead of the ones listed on the Canopus transition list.
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The Canopus Chromakey, Canopus Luminancekey, and Canopus Picture in Picture transitions allow
you to use those filters as transitions. When used as transitions, the underlying video will appear on
the preview.

Adding video or audio filters

All of the Canopus video or audio effect filters except for Slow Motion are available in Premiere Pro.

1. To add a Canopus video or audio effect filter to a clip, choose either of the Canopus Video Filter or
Canopus Audio Filter from the Effects list tab in the Project window, which is under the Video Effects
folder.

2. Drag the filter you selected and drop it onto a clip located on the timeline.
The Monitor window opens with the Effect Controls tab selected.
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3. Click  in the tab to bring up the dialog for specifying detailed settings.
In this case below, the Video filter dialog opens.

4. Choose one or more filters by adding them to the list, and you can get the setup by clicking the
appropriate Setup button.

5. Preview the filter by using the filter preview controls in the filter settings and at the bottom of the
filter list.
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Adding motion to titles

1. To add a Canopus title motion filter to a clip, choose Canopus Title Motion Filter from the Effects list
tab in the Project window, which is under the Video Effects folder.

2. Drag the filter and drop it onto a clip located on the timeline.
The Monitor window opens with the Effect Controls tab selected.

3. Click  in the tab to bring up the Title dialog for specifying detailed settings.
The Title dialog opens.
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4. Set the Motion as well as the Time for the In and Out motion.

5. Click OK to apply the Canopus Title Motion to Premiere Pro titles - even if you simply use the Cut
motions.

Having the filter applied will reduce the CPU load for displaying Premiere Pro titles. It also makes it
easy to precisely control in and out effects.

You can apply multiple title motion filters to get very neat effects. For example, you can combine a
Slide Left with a Slide Up to have a diagonal up-left slide in.

Use the title motion filter with In and Out times set to half the length of the clip and Motions set to the
same Slide effect for real-time scrolling titles.

You can also apply the Canopus Title Motion Filter to video clips to give them exciting in and out
effects.
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Playing the Timeline

The timeline will play back in real-time as long as you aren't using non-real-time filters or transitions, and you
are not exceeding the real-time power of your system. The amount you can do in real-time depends mainly
on your CPU power and the individual limitations of your editing system. Your playback ability also depends
on the playback settings you have enabled.

Sections of the timeline that may not play back in real-time are marked with a red line below the playback area bar.

The plug-in playback settings affect certain features as well as the amount you can do in real-time. Please
refer to "Playback Settings" at the previous section.

Playback Buffer and Non-Real-Time Effects

About the playback buffer

The buffer counter can be enabled in the Playback Settings dialog (see Playback Settings at the previous
section). The playback buffer allows the system to play back in real-time through short areas that have more
effects than could normally be handled.

As the duration of the "overloaded" area increases, the playback buffer gets depleted. When this counter
runs out, the system is no longer able to process in real-time and frames get dropped (or playback stops).

The playback buffer gets replenished as the system goes through areas that have enough CPU power to
process. You can also start playback with the playback buffer pre-filled by holding down the Shift key and
clicking the Play button on the target side of the Monitor window.

The default size of the playback buffer is 1 second. However, if you have 192MB or more, you can increase
the size of the playback buffer in the Detailed Settings of the DVStorm-RT Properties (see Setting the Device
Control at the previous section).
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Non-real-time effects

Some non-real-time effects can be played back in real-time, depending on the situation.

Non-real-time effects playback uses the playback buffer described above to do the processing. Thus, there
must be a sufficient amount of time for the effect to render on-the-fly, enough time between effects for the
playback buffer to "recharge," and effects cannot be too long in duration.

Timeline Output
You can output your timeline to a DV device directly from Premiere Pro using Premiere Pro's Export to Tape
function. For output to analog devices, you can simply play the timeline or use Premiere Pro's Print to Video
function.

Export to tape

1. Preview the timeline once-through to make sure any sections that need rendering are rendered
for recording the timeline to a DV device.

2. Select Export to Tape from the File menu.
The DVStorm-RT Deck Control window opens.

3. Use the deck controls to position the tape where you want to start recording at.
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4. When you are ready to record the timeline out to the DV device, click the Tape Out button at the
top of the window.
The deck will start recording, and the timeline will play out to tape automatically.

Video Out Plug-Ins

After Effects Plug-In
You can work while checking effect states by sending the video displayed in the Adobe After Effects
composition window from the DVStorm video output connector to a TV monitor.
Supported version: After Effects 6.0

NOTE:
• Changes made in the settings are not reflected immediately. They are reflected

when you click inside the Composition window, scrub in the Timeline window, or
perform some other operation.

• If RAM preview playback is not smooth, use the dialog that opens when you click
Edit > Environment settings > Cache to set Image cache size to a smaller value.

• Use the NTSC DV presets or the PAL D1/DV presets to make composition settings,
depending on the video standard you are using.

Frame size: 720 x 480 (NTSC), 720 x 576 (PAL)
Pixel aspect ratio: D1/DV NTSC (NTSC), D1/DV PAL (PAL)
Frame rate: 29.97 frames/sec (NTSC), 25 frames/sec (PAL)

• Set up the render frame output module as follows:
Output module: Custom
Format: Video for Windows
Format option: CANOPUS DVRex Codec or Canopus DV Codec
Video output: Make the following settings; 48.000 kHz 16-bit stereo,

44.100 kHz 16-bit stereo, 32.000 kHz 16-bit stereo
• Compression and cropping are not supported.
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Limitations

• The 16-bit/channel color of After Effects 5.5 is not supported.
• RAM previews may not be carried out in real time at maximum size.
• Analog output is not possible in the Clip window. To preview clips, use the Layer window. The Layer

window can be opened by holding down the Alt key and double clicking in the Project window.
• Analog output is not possible in the Composition window and the Layer window while the Clip window is

open.
• Depending on your video card, magenta noise may be visible in the Clip window when your mouse pointer

is set up to be displayed with a shadow.

How to use

Connect the video output connector of the Storm board to a TV monitor.

1. Select the Edit menu in After Effects.

2. Select Preferences > Canopus VideoOut.
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3. Make the following settings in the Canopus VideoOut dialog.

• Enable video out - When this is checked, rendering results are output to the monitor.
• Maximize - When this is checked, the Composition window is expanded or reduced to 720 x 480

(NTSC) or 720 x 576 (PAL).

Photoshop Video Out Plug-In
You can output images shown in Adobe Photoshop to a TV monitor from the DVStorm video output connector.
This allows you to use images created in Photoshop as video material, and adjust images for the optimum
color balance for video.
Supported versions: Photoshop 7.0, Photoshop Elements 2.0

How to use

Connect the video output connector of the Storm board to a TV monitor.

1. Start Photoshop, and open the file that you want to output to video.

2. From the File menu, select Write Data > Canopus Video Out.

A still picture appears on the TV monitor.
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Calling by keyboard shortcut

By registering a new action, you can use keyboard shortcuts and function keys to call up video output.

Registration procedure

1. Display the Action window and select the Action tab, then click Create new action.

2. In the New Action window that appears, enter the action name, enter a function key or shortcut,
and click Register.

3. From the File menu, select Export > Canopus Video Out.

4. Click Stop Playback/Recording.

LightWave 3D Video Out Plug-In
You can output animations shown in LightWave 3D to a monitor from the video output connector of DVStorm.
Supported version: LightWave 3D 7.5

How to use

Connect the video output connector of the Storm board to a TV monitor.

1. From the Layout menu, select Plug-ins > Add Plug-ins...
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2. Select Canopus VideoOut.p, which is located in C:\Program Files\Canopus\VideoOut Plugin.

3. Click OK.

4. Select Render Options from the Rendering menu.
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5. Check Show Rendering in Process, and select Canopus VideoOut as the display destination.

6. From the Rendering menu, select Render Current Frame or Render scene.
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Rendering starts.

7. Click Continue to start the video output.
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When the output ends, you are returned to the original screen.
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Canopus DV Capture

Chapter 6

This chapter describes details of Canopus DV Capture.
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Canopus DV Capture
This is a DV capture application for DV capture via general IEEE1394 boards and for
simultaneous capture with the DVStorm2 unit. You can connect at most 3 cameras for
capturing images. With this application, you can capture 3 images simultaneously from
two cameras connected to the IEEE1394 boards and one camera connected to the
DVStorm2 unit.

The application also has a function for dividing input automatically into separate files, which works by
detecting breaks in DV timecode sequences. Three streams can only be achieved with a DVStorm2 unit, and
2 IEEE1394 boards (OHCI cards) present (please refer to the below table).

Table: Number of devices required for multiple stream capture

Device Type

DVStorm2 unit

DVStorm2 unit

OHCI Card

DVStorm2 unit

OHCI Card with 2 IEEE1394 ports

Video Streams Captured

1

2

3

No. Devices Installed

1

2

3

Hardware and Software Requirements
Hardware and software requirements for Canopus DV Capture are as follows. However, operation is not
guaranteed in all environments meeting these requirements.

OS - Windows 2000 Professional SP2 or higher, Windows XP Home Edition or Professional Edition, DirectX
8.1 or higher

CPU - Pentium III 500 MHz (Pentium III 1 GHz or higher is recommended)

Memory - 256 MB or higher

Hard disk - 5400 rpm (7200 rpm or higher is recommended)

Other - Necessary to install DVStorm2 unit in your computer, Necessary to have version 2.0 or higher of
the supplied drivers and applications

NOTE:
Video color depth should be set to at least 16-bit (65,536 colors). When color depth is
256 colors, the output state of the current file and the VTR operating state are not
reflected by the buttons of this application.
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Limitations

The following limitations apply due to limitations in Windows specifications (as of September 2002).

• When multiple DV devices are connected to a general IEEE1394 board (OHCI card), the devices may not
be recognized and may not operate normally. In some cases, these problems can be avoided if you
power on the DV devices, connect them to the computer, and then power the computer on. Capture
operation has been found to be unstable when 3 or more DV devices are connected to an IEEE1394
board at the same time.

• When 2 or more DV devices connected to an IEEE1394 board and selected onscreen, and one of the
devices is powered off or disconnected, the other DV devices may be affected. Especially, when the first
device recognized by Windows is powered off or disconnected, devices recognized later may be affected,
resulting in dropped frames or capture halt. (However, devices connected to DVStorm2 unit are not
affected.)

• When multiple IEEE1394 boards are installed in a computer, DV devices connected to one of the boards
only are recognized.

Installation
To install this application, use DVStorm2 Pro Application CD. The setup launcher screen will open automatically
after inserting the CD to your CD-ROM drive. Click [Install DVStorm Applications] on the screen to start the
installation. Normally, the installation of this application will start right after the installation of MPEGcraft LE
and MPEGcapture.

When you want to install Canopus DV Capture by itself, locate and run Setup.exe under DVCapture folder in
the DVStorm2 Pro Application CD. Follow the on-screen instructions to install manually.

How to Use

1. Start Canopus DV Capture.

2. Make the required settings in the Options screen.



72

Chapter 6

Each capture window contains:
• Open  - Allows to choose the directory and name the file for each capture window.

• Deck controls

• Recording controls

• Time code capture button

• Consecutive numbering of the same file name (On/Off) button when sectioning the
video stream.

• Frame by frame Capture  - Allows to manual capture individual frames. This is used in stop
motion animation of in animate objects. (e.g. Doll appearing to move.)

DV Capture Functions

File Menu - Settings for DVStorm
Before capturing with this application, please make sure the following settings.
To configure settings for DVStorm2 unit, click File > Settings > DVStorm tab.
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Video Signal

These settings control the set up of the DVStorm2 unit.
• Video format - Select from PAL or NTSC.
• Input - Select from Composite or S-Video.
• Setup level - Select IRE level from 0IRE or 7.5IRE.

Image Quality

Image quality is easily adjusted using the image quality settings of Brightness, Contrast, Saturation, Hue, and
Sharpness.

File Menu - Settings for Options
Before capturing with this application, please make sure the following settings.
To configure optional settings, click File > Settings > Options tab.

Options

• Time interval - (Time Code Related) When  button is depressed (red light on), the amount of time
chosen indicates the time interval between filming different clips (i.e. 6:00PM and 6:30PM) if the time difference
when the original clips were shot is more than the selected time then a new file is automatically created. For
example if you choose 10 seconds, and you recorded a birthday party, if the time between stopping the tape
and starting to record again is more than 10 seconds a new file will be created when capturing.

• AVI file type - Select the AVI file format from Canopus format (high quality proprietary) or MS format.
• Default directory - Choose the default directory to which all streams are captured clicking [Open].

NOTE:
When you change NTSC to PAL in the Video format setting (or vise versa), the dialog
asking you to reboot your computer will appear. When you see the dialog, exit Canopus
DV Capture first, then restart your computer.
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Commands Under Window Menu

Preview

Indicates the channels that you wish to preview. You may select all three channels or any combination there of.

Channel No.

Indicates the number of channels to be captured. You may select 1, 2, or 3 channels to capture video.

Arrangement

Arranges the capture preview windows either horizontally or vertically depending on the workspace available.



MPEGcapture

Chapter 7

This chapter describes details of MPEGcapture for
DVStorm.
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MPEGcapture for DVStorm
This is an application for capturing MPEG1/2 files directly from video (both S-video and
composite) /audio/DV jack of the DVStorm2 unit with Canopus StormEncoder. You can
also preview the captured files with DVStorm2 unit in realtime.

This application software is only available in DVStorm2 Pro.

Hardware and Software Requirements
To use MPEGcapture, you are required to have installed the following in your computer:

• StormEncoder*
• EDIUS LE V.1.5

* This may not be included in the package according to the one you purchased.

Installation
To install this application, use DVStorm2 Pro Application CD. The setup launcher screen will open automatically
after inserting the CD to your CD-ROM drive. Click [Install DVStorm Applications] on the screen to start the
installation. Normally, the installation of this application will start right after the installation of MPEGcraft LE.

When you want to install MPEGcapture by itself, follow below instructions.

1. Locate and run MPEGcapture.exe under MPEGcapture folder in the DVStorm2 Pro Application CD.
"MPEGcapture for Storm - InstallShield Wizard" window will appear on screen.

2. Click [Next].
"Install MPEGcapture for Storm to" will appear on screen.

3. Click [Change] if you want to change the installation destination folder. If not, go on to the next step
clicking [Next].
"Install to begin the installation" will appear on screen.

4. Click [Install] to start the installation.
"InstallShield Wizard Complete" will appear on screen.

5. Click [Finish] to finish the installation.
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How to Use

Capturing

1. To start the application, click Start button > Programs > Canopus > EDIUS > MPEGcapture for
Storm.
MPEGcapture for Storm will appear on screen.

2. Click  to display MPEG1/2 file settings window.

3. Change the settings here if you need to.

NOTE:
You can not open MPEGcapture and EDIUS LE at the same time.
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4. Click  to show file save/ format settings window.

5. Set the folder destination and file format.

6. Click  to start capturing.

7. Click  at the upper right corner to close the application.

File Previewing

1. To start the application, click Start button > Programs > Canopus > EDIUS > MPEGcapture for Storm.
MPEGcapture for Storm will appear on screen.

2. Click  to show file save/ format settings window.

3. Set the file format, specify the destination folder to save the file, and click [Save].

4. Click  to start previewing.
The preview may take a few seconds to start/ close.

5. Click  at the upper right corner to close the application.



Power Management Property

Chapter 8

This chapter describes details of Power Management
Property for supporting Window's Power Management
modes.
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Support for Power Management Modes
Under Windows 2000 and Windows XP, some systems are unstable in Standby mode.
If your system does not recover normally from Shutdown/Reboot/Standby, please
change the power management mode.

1. Start PwrProp.exe on a Winodows 2000/XP system with the driver installed.
PwrProp.exe is located in the DVStorm-RT folder.

2. Change the power management mode.
The change will become take effect the next time that Windows 2000/XP starts.

3. Immediately after the driver is installed, mode (1) is selected. If you need to change this, select
mode (2) first. and select mode (3) if the system is still unstable.

(1) Conform to Windows 2000
This operates as a power policy owner based on the Windows 2000 Device Driver Kit (build 2195).

(2) Conform to Windows 98 WDM
This operates as a power policy owner based on the Windows 98 Device Driver Kit (or the Windows
2000 Release Candidate 2 Device Driver Kit).

(3) Disable Power Management
This disables power management. IRP processing requests from the Power Manager are passed to
a low-level driver.



Notes and Limitations

Chapter 9

This chapter describes some limitations of DVStorm2 Pro.
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Scalable Technology Explained
Unlike other realtime editing products, Canopus technology abstracts the complex
processing away from the hardware and uses the CPU power of the system to achieve
its realtime processing.

Since CPU speeds increase constantly, Canopus realtime capabilities increase as you upgrade your system.
This keeps your Canopus hardware from becoming obsolete. New features can be added by simply upgrading
the software. Increased realtime functionality can be added by simply upgrading the speed of your system.

Realtime Capabilities
It is difficult to answer the question "What can I do in realtime?" The information that
follows details the realtime functionality of scenarios we have tested. Since CPU speeds
increase rapidly, there will obviously be more that can be done in the future. Please
check the Canopus website for the latest performance information.

Minimum CPU Requirements
The tables that follow describe the minimum CPU speeds necessary to perform certain effects or sets of
effects.

These minimums should be used as a guide only - individual system differences such as motherboard
differences, CPU bus speed, hard disk transfer speeds, drive controller CPU utilization, background services
and applications, operating system utilization and various other factors will make your individual results vary.

For example, "Single Filter in realtime" specifies the minimum system speed required to play clips with a
single filter applied.

This does not mean that you can only have one clip on the timeline, or only use one filter within the entire
timeline. This just means that at any single point in time on the timeline, there is only one clip with one filter on
it. There can be other clips at that point in time on the timeline, but they cannot have filters applied to them.

A simple example: clip A has Picture-in-Picture applied to it and is playing over clip B which has Motion Blur
applied to it. This would be a case of two filters - one on clip A (Picture-in-Picture) and one on clip B (Motion
Blur).

A slightly more complex example: clip A has Emboss applied to it, clip B has Motion Blur applied to it, and there
is a transition between them. Now there are three effects happening at one time - Emboss on clip A, Motion
Blur on clip B, and the transition between them.

A final complex example: clip A has Emboss applied to it, clip B has Pencil Sketch and Motion Blur applied to
it, there is a transition between clip A and clip B, and clip C has Picture-in-Picture applied to it. Now there are
five effects happening at one time - Emboss on clip A, Motion Blur and Pencil Sketch on clip B, the transition
between A and B, and the Picture-in-Picture on clip C.



83

Notes and Limitations

Table 1: Transition effects in real-time

Effect

Any basic transition effect except Push Stretch

(Alpha, Blind Push, Blind Slide, Blind Wipe, Block, Box, Clock, Circle, Dissolve, 

Stripe, Stretch, Slide)

Any basic transition effect including Push Stretch

One to ten tracks of titling

(1/10 screen size with dissolve in/out effect)

Minimum CPU Speed

Single 500 MHz

Single 933 MHz

Single 500 MHz

Table 2: Single filter in real-time

Filter

Noise

Blur

High Quality Blur

Color Correction

Emboss

Pencil Sketch

Monochromatic

Mosaic

Motion Blur

Sharp

Soft Focus

Old Movie

Minimum CPU Speed

Single 500 MHz

Single 933 MHz

Dual 600 MHz

Single 500 MHz

Single 500 MHz

Single 500 MHz

Single 500 MHz

Single 500 MHz

Single 933 MHz

Single 700 MHz

Dual 600 MHz

Dual 600 MHz
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Table 3: Picture-in-Picture, Keying, and Slow Motion

Effect

High Quality Picture-in-Picture

(1/4 screen size with edge and shadow)

Standard Quality Picture-in-Picture

(1/4 screen size with edge and shadow)

Chroma Key

Luminance Key

Slow Motion

(1/2 speed, no audio)

Minimum CPU Speed

Single 933 MHz

Single 700 MHz

Dual 700 MHz

Single 933 MHz

Single 500 MHz


